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1 Foreword

INFORMATION

Date of last update: 2021-12-21

» Please read this document carefully before using the product and observe the safety
notices.

» Please contact the manufacturer if you have questions about the product or in case of prob-
lems.

» Report each serious incident related to the product to the manufacturer and to the relevant
authority in your country. This is particularly important when there is a decline in the health
state.

» Please keep this document for your records.

The "4X440=V1.10 C-Soft Plus 1.10" adjustment software is referred to below as C-Soft Plus,
software or adjustment software.

Only put the product into use in accordance with the information contained in the accompanying
documents supplied.

2 Product description

2.1 Function

The "C-Soft Plus" software is designed for the patient-specific adjustment of the products
3C98-3=*, 3C88-3=*. The integrated alignment recommendation supports optimum adaptation of
the component to the patient.

Communication between the software and the prosthesis takes place exclusively via Bluetooth
data transfer.

2.2 Combination possibilities

Supported Bluetooth adapter
e 60X5 BionicLink PC

Products that can be adjusted
 3(C88-3=*, 3C98-3=*

3 Intended use

3.1 Indications for use
The "C-Soft Plus" software is designed for the patient-specific adjustment of the products
3C88-3=*, 3C98-3=*.

3.2 Conditions of use
* For the software to be able to be used, the PC must fulfil the system requirements.
* The battery of the prosthesis must be charged.

3.3 Contraindications
* All conditions which contradict or go beyond the specifications listed in the section on
"Safety" and "Indications for use".

3.4 Qualification

The adjustment software may only be used by qualified personnel that has participated in the rel-
evant product training and has been certified for the application. Additional product training
courses may become necessary to qualify for software updates.



4 Safety

4.1 Explanation of warning symbols

Warning regarding possible serious risks of accident or injury.

Warning regarding possible risks of accident or injury.

INOTICE | Warning regarding possible technical damage.

4.2 Structure of the safety instructions

The heading describes the source and/or the type of hazard

The introduction describes the consequences in case of failure to observe the safety instruc-

tions. Consequences are presented as follows if more than one consequence is possible:

> E.g.: Consequence 1 in the event of failure to observe the hazard

> E.g.: Consequence 2 in the event of failure to observe the hazard

» This symbol identifies activities/actions that must be observed/carried out in order to avert
the hazard.

4.3 General safety instructions

Non-observance of safety notices
Personal injury/damage to the product due to using the product in certain situations.
» Observe the safety notices and the stated precautions in this accompanying document.

/A WARNING

Outdated version of the product information on the data carrier

Personal injury/damage to the product may result from insufficient information about product

handling.

» Please note that the product information on the data carrier may not be current.

» Please refer to the product information included with each respective delivery or handed out
during product training.

» To find out whether your product information is up to date, please contact an authorised
Ottobock Service Centre.

/\ CAUTION

Operator errors when adjusting settings using the adjustment software

Falling due to unexpected prosthesis behaviour.

» Do not charge the prosthesis battery during the adjustment process since the prosthesis is
not functional while the battery is being charged.

» During the adjustment process, the prosthesis must not remain unattended when connected
to the adjustment software while being worn by the patient.

» Observe the maximum range of the Bluetooth connection and note that obstacles may limit
this range.

» During the data transfer (PC to prosthesis), the prosthesis wearer should sit or stand still,
and the BionicLink PC must not be removed from the computer.




» If you want to make only temporary changes to the settings while connected to the adjust-
ment software, you must reverse these changes before disconnecting the adjustment soft-
ware.

You must also ensure the patient does not leave the range of the Bluetooth connection if set-
tings have been changed temporarily.

» Inform the patient immediately if the data connection is accidentally interrupted during the
adjustment process.

» The connection to the prosthesis must always be disconnected after adjustments have been
completed.

» Successful participation in an Ottobock product training course is mandatory prior to initial
use. Additional product training courses may be required to qualify for software updates.

» The correct input of the foot size, prosthesis dimensions, body weight and calibration are
important criteria for achieving a quality fitting. If the values are too high, the prosthesis may
not switch to the swing phase. If the values are too low, the prosthesis may trigger the swing
phase at the wrong time.

» If the patient uses walking aids (e.g., crutches or walking canes) during the adjustment pro-
cess, you will need to readjust the settings when the patient no longer requires these aids.

» Use the online help function integrated into the software.

» Do not disclose your personal access data.

NoTice.

Connecting the data carrier to a USB connection that is not easily accessible on the

computer

In the event of a fault, you will not be able to disconnect the power supply to the data carrier

immediately.

» Connect the data carrier only to USB connections that can be easily accessed on the com-
puter.

INFORMATION

» Please note that observing the prescribed system requirements is mandatory.

» It is recommended that you do not run any other programs during installation and use of the
adjustment software, since this can affect performance.

» If you require further information, contact the Ottobock office responsible for your country.

INFORMATION |

Cybersecurity

» Keep your operating system up to date and always install any available security updates.

» Protect your computer from unauthorised access (e.g., by using virus scans, password pro-
tection etc.).

» Do not use unsecured networks.

» Please contact the manufacturer if you suspect cybersecurity problems.

5 Scope of delivery
* 1 pc. 4X440=V1.10 C-Soft Plus 1.10 USB data carrier
* 1 pc. Instructions for use (qualified personnel)



6 System Requirements

6.1 Minimum PC Hardware Requirements

The minimum hardware requirements for installation/use of the adjustment software apply inde-

pendently of the operating system being used. If the minimum requirements for using the operat-

ing system are higher than the hardware requirements described here, the minimum requirements

for the operating system apply.

* PC with an Intel Core2 processor (x64) or faster

+ 2GBRAM

* Atleast 5 GB free hard drive space

* Graphics card with Open GL support

* Resolution 1280 x 768

» Display scale 100% or 96 DPI (settings above 150% can cause display problems depending
on the chosen resolution)

*  32-bit colour depth (16.7 million colours)

* 1 free USB connection 2.0 or higher

* Mouse and keyboard

6.2 Supported operating systems
The following 64-bit operating systems are supported:

INFORMATION

32-bit operating systems are no longer supported.

*  Microsoft Windows 7, SP1 or higher, all editions except Microsoft Windows 7 Starter
¢  Microsoft Windows 10

INFORMATION |

Please note that the latest USB driver version must always be installed for the Bluetooth connec-
tion via the 60X5 BionicLink PC. You can download the latest driver version from the following
site: http://ottobock.com/en/datastation/. The latest version can also be downloaded via the
"software update" function (see page 12).

6.3 Additional Recommended Software Components

The following software components are recommended:

* Internet browser

* Aninstalled program for sending e-mail (e.g. Microsoft Outlook, Mozilla Thunderbird...).

6.4 Additional Installed Software Components

The following additional software components are required and installed during installation of the
software (if they are not already installed on the PC):

*  Microsoft .NET Framework 4.5.2

| INFORMATION |

Before the installation is started, the installation program checks if there is sufficient free space
on the hard drive and returns an error message if this is not the case. If this occurs, a corres-
ponding amount of space must be freed up on the hard drive. All components required by the
Ottobock software are copied to the hard drive automatically by the installation program.

7 Installation

Installation information
* Please note that observing the prescribed system requirements is mandatory.



* |t is recommended that you do not run any other programs during installation and use of the
adjustment software, since this can affect performance.
*  You must have administrator rights to install the software.

Carrying out the installation

1) Start Microsoft Windows.

2) If necessary, poke the USB data carrier out from the card.
INFORMATION: The data carrier cannot be detached
from the card.
Connect the data carrier to a freely accessible USB connec-
tion. The golden contacts should face upwards.
— Microsoft Windows will automatically recognise the data

carrier.
4) Follow the on-screen instructions to perform the installation.

)

INFORMATION |

The installation does not start automatically

» Open "Computer" (key combination [Windows logo key s@+E])
» Click the folder with the Data Station symbol .

» Start the installation by double-clicking "setup" or "setup.exe".

After the installation program starts, follow the on-screen instructions.
Information: fields marked with an asterisk (*) are mandatory.

17, Ollobock - nstalShield Wizard B When the "Registration result" window is displayed, the fol-
e e ) 4 lowing options are available to continue the installation:
P I * Continue installation without registration
e — . X . . . .
e * Continue installation with registration
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7.1 Continue Installation Without Registration

17 Oliobock - Instalhield Wizard i If you do not want to register, click the "Skip registration" but-
ton and follow the further instructions of the installation wizard.
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Once installation is complete, an icon for starting the Ottobock
Data Station is added to the Windows desktop. The "C-Soft
Plus" software can be accessed after the Ottobock Data Station
has been started.

The Ottobock Data Station is a superordinate software platform
used to launch the corresponding programs. For this reason a
separate icon for the "C-Soft Plus" software is not created dur-
ing installation.

7.2 Continue Installation With Registration

i Oftobock - InstallShield Wizard 3]
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In order to register, enter the company information and then
click the "Next" button.

When the summary of the data already entered appears, the fol-
lowing possibilities (buttons) are available for registering the
software:

Standard e-mail program available ("Send registration" button)

If you are able to send emails using a standard email program
(e.g. Microsoft Outlook, Mozilla Thunderbird), carry out the fol-
lowing steps:
1. Click the "Send registration" button.
An email with the required registration data is sent automat-
ically.

Webmail available ("Copy to Clipboard" button)

@io

@ fo)

If you do not use a standard email program, but have access to

the Internet from your PC, carry out the following steps:

1. Click the "Copy to Clipboard" button.

2. Paste the contents of the clipboard into the text field of your
webmail email client (e.g. Gmail, Yahoo ...) with the key
combination [Ctrl+V] or with the right mouse button.
Information: automatic processing is only possible
when this method is used.

3. Send the email to the following address:
registration.austria@ottobock.com



Fax available ("Print" button)

If you do not have an Internet connection, carry out the follow-
ing steps:
1. Click the "Print" button to make a printed copy.
2. Send the printout by fax to the following address:
(+43-1) 526 79 85 * Otto Bock Healthcare Products
GmbH * BrehmstraBe 16 * 1110 Vienna * Austria.

Follow the subsequent instructions of the installation wizard.

. Once installation is complete, an icon for starting the Ottobock
Data Station is added to the Windows desktop. The "C-Soft

Plus" software can be accessed after the Ottobock Data Station
has been started.
The Ottobock Data Station is a superordinate software platform
used to launch the corresponding programs. For this reason a
separate icon for the "C-Soft Plus" software is not created dur-
ing installation.

8 Data Transfer between the Prosthesis and PC

Prosthesis settings using the adjustment software can only be made via Bluetooth data transfer.
In order to do so, a Bluetooth wireless connection must be established between the prosthesis
and the PC with the help of the 60X5 BionicLink PC. To install the 60X5 BionicLink PC for the
first time, follow the procedure described in the instructions for use supplied with this adapter.

| INFORMATION |

Do not disconnect the 60X5 BionicLink PC from the PC when there is an active Bluetooth con-
nection.

| INFORMATION |
The adjustment software does not support the 60X4 (Anycom) BionicLink PC adapter.

8.1 Establishing a Bluetooth Connection to the Prosthesis

1) Note the serial number of the component you want to connect.

2) Connect/disconnect the battery charger, or
Hold the prosthesis with the knee head down (turn it upside-down), keep it still and wait for
feedback signals.
Information: If no feedback signals are produced, this may have the following causes: Feed-
back signal volume reduced, prosthesis battery drained or prosthesis switched off.

3) Click the "Connect" button within 2 minutes and, in the window that opens, select the corres-
ponding component from the list according to the serial number.
Information: The Bluetooth function or Bluetooth recognition of the component is turned off
after 2 minutes. When a connection with the PC is active (the —@D— icon is lit up), the
Bluetooth function is not switched off automatically.

— After successfully establishing a connection to the PC using the 60X5 BionicLink PC, the blue
LED on the prosthesis and the blue LED of the BionicLink PC flash.

INFORMATION

If the connection is reestablished within a previously opened job after the connection was lost,
no steps are required for recognition of the component.
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9 Starting the Program

| INFORMATION |

rights.

To run the software, ensure that the user is logged on to the PC with at least standard user

Data Station
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Double-click the A icon (Ottobock Data Station) on the
desktop. The program starts.

After the Ottobock Data Station has been started the first
step is to create a new patient record (click the "Add
Patient" button) (item 1) or select an existing patient record
(item 2).

Information: fields marked with an asterisk (*) are man-
datory.

Click the "Add Job" button (item 3).

Click the "C-Soft Plus" button. You will find this on the
"Prosthetic Lower Extremity" tab.

Prior to first use, the corresponding information has to be
entered into the "Username" and "Unlock-PIN" fields.
Information: Make sure to use correct spelling
(upper/lower case) when entering the information.
Click the "Log On" button.

After entering the unlock PIN and clicking the "Log On"
button you will be asked to enter and confirm a password of
your own choice.

Information: the password entry window only appears
after you have entered the unlock PIN. If you have
already entered a password in the previous step, the
password entry screen will not appear.

Click the "OK" button.

11



* Next, the screen for establishing the connection to the pros-
thesis appears.
Information: The tube adapter configuration tool can
be used without a connection to the prosthesis by
clicking the ¢symbol.

* Click the "Connect" button to establish a connection with
the prosthesis.
If there are several prostheses within range, compare the
serial number shown with the serial number of the prosthes-
is with which you want to connect.
Information: The serial number is found on the inside
of the knee joint frame.

*  Once the connection to the prosthesis has been estab-
lished, the —@— symbol appears in the top right corner.

| INFORMATION

If the connection is disrupted during operation, see the section "Troubleshooting" (see
page 13).

10 Closing the Program

The following options are available for closing the program:

* Click "File > Exit" in the menu bar

* Click the "X" button in the top right corner of the program window
* Press the key combination [Alt+F4]

11 Uninstalling

To uninstall the Ottobock software, use the Windows uninstall function.

All components of the adjustment software are deleted during the uninstall. If another adjustment
software is installed within the Data Station, the Data Station remains, otherwise it is deleted as
well.

However, the entered patient data are not deleted.

12 Further Information

12.1 Information Regarding the Online Help

General Online Help
The online help can be accessed via the F1 button or the "Help > Contents ..." menu bar.

Online help for the currently displayed page
Information on the page currently being displayed in the adjustment software can be accessed by
clicking the @ symbol.

12.2 Obtaining Program Version Information
The current program version of the installed software can be obtained from the menu bar. You
should have this information available whenever you contact the software support.
1) Click "Help > About" in the menu bar.
— A window with the currently installed software will open.
2) Click on the desired entry to obtain further information.

12.3 Software Updates
1) Click "Help > About" in the menu bar of the Data Station when you are connected to the
Internet.

12



— The window opens with the versions of the previously installed programs and the manu-
facturer's address.
2) Click the "Check for updates" button in this window.
— A search for updates of previously installed software products and components is per-
formed via the Internet.
3) If updates are available, click "Download" in the column on the right in order to download
and save the update.
4) Extract the "ZIP file" and execute it.

13 Troubleshooting

Causes of connection errors (-di{- symbol appears)

If the -@@- symbol appears in the software's user interface, the connection to the prosthesis
was severed.

Verify operational readiness of the 60X5 BionicLink PC and the prosthesis using the table below.
Eliminate any causes that apply.

Event Cause/required action
The blue LED on the prosthes- | Prosthesis switched off
is is not lit up * Connect/disconnect the battery charger on the prosthesis

to turn the prosthesis on.

Bluetooth on the prosthesis is switched off

* Rotate the prosthesis by 180° (the sole of the foot has to
face up) or connect/disconnect the battery charger to turn
on Bluetooth for approx. 2 minutes. You must attempt to
connect again during this time.

Prosthesis battery drained
* Charge the prosthesis battery.

The blue LED on the prosthes- | Connection to the PC disrupted because the distance to the

is is lit up continuously prosthesis is too large
* Reduce the distance between the prosthesis and the 60X5
BionicLink PC.
The green LED on the 60X5 The 60X5 BionicLink PC is not operational
BionicLink PC is not lit up * Check the connection of the BionicLink on the PC.

* Connect the BionicLink to a different USB port on the PC.
* If a hub is being used, connect the BionicLink directly to
the USB port on the PC.

The blue LED on the 60X5 Connection to the PC disrupted because the distance to the
BionicLink PC is not lit up prosthesis is too large
* Reduce the distance between the prosthesis and the 60X5
BionicLink PC.

Once the blue LED on the prosthesis and the green LED on the 60X5 BionicLink PC light up after
eliminating the cause of the problem, start another connection attempt.

If a connection still cannot be established, contact the Ottobock branch responsible for your
country.

When the connection has been restored, check the most recently configured settings.

14 Trademarks

All product names mentioned in this document are subject without restriction to the respective
applicable trademark laws and are the property of the respective owners.

All brands, trade names or company names may be registered trademarks and are the property of
the respective owners.
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Should trademarks used in this document fail to be explicitly identified as such, this does not justi-
fy the conclusion that the denotation in question is free of third-party rights.

Microsoft, Outlook and Windows are registered trademarks of Microsoft Corporation.

Pentium, Intel and Intel Core are registered trademarks of Intel Corporation.

15 CE conformity

Otto Bock Healthcare Products GmbH hereby declares that the product is in compliance with
applicable European requirements for medical devices.

The full text of the regulations and requirements is available at the following Internet address:
http://www.ottobock.com/conformity

16 Symbols Used

I Manufacturer

C E Declaration of conformity according to the applicable European directives

Article number

Licence Agreement

Manufacturer: see back of this document

PLEASE READ THIS END USER LICENCE AGREEMENT ("TERMS OF USE" OR "LICENCE AGREEMENT")
CAREFULLY BEFORE YOU INSTALL OR USE THE OTTOBOCK SOFTWARE. BY INSTALLING OR USING THE
OTTOBOCK SOFTWARE, YOU ARE AGREEING TO THE TERMS AND CONDITIONS OF THIS TERMS OF USE.
DO NOT USE THE OTTOBOCK SOFTWARE UNLESS YOU AGREE TO THE TERMS AND CONDITIONS OF THIS
LICENCE AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENCE
AGREEMENT, YOU CAN RETURN THE OTTOBOCK SOFTWARE TO THE LOCATION WHERE YOU ACQUIRED
THE SOFTWARE. IF YOU ACQUIRED THE OTTOBOCK SOFTWARE JOINTLY AND IN CONJUNCTION WITH
HARDWARE, YOU CAN RETURN BOTH THE HARDWARE AND THE SOFTWARE.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THESE TERMS OF USE, YOU ARE NOT
AUTHORISED TO INSTALL OR USE THE OTTOBOCK SOFTWARE.

1. Contractual partners and object of the agreement

1.1 By accepting these Terms of Use, you are entering into a contract between yourself and the named Ottobock com-
pany (hereinafter also “Ottobock”); however, if you are acting on behalf of a company when installing or using the
Ottobock software (e.g. as an employee of said company), the contract is concluded between the company and
Ottobock (in which case “you” refers to said company). In case of any doubt, you are a party to the contract.

1.2 The licence covers the Ottobock software, including any related documentation (referred to as “Ottobock
Software” below). The terms and conditions of this licence agreement also apply to any updates to the Ottobock soft-
ware that replace or amend the original software — where Ottobock provides them to you after the installation of the
Ottobock software — unless such an update is the object of a separate licence agreement. Any possible maintenance
of the Ottobock software or other Ottobock products is not covered by this agreement; a separate agreement is
required.

1.3 To the extent that the Ottobock software will be used to provide recommendations regarding patient fittings (e.g.
for certain adjustments to Ottobock products after taking customer measurements), please note that such suggestions
merely represent non-binding recommendations from Ottobock. While Ottobock will take reasonable steps to ensure
the suggestions are correct, it is not obliged to provide technically accurate recommendations. Accordingly, Ottobock
is not liable for possible technical errors in the recommendations except in the case of intent or gross negligence.

Your own technical responsibility for correct patient fittings remains unaffected by the non-binding recommendations.
1.4 To the extent that training requirements are specified for the use of the Ottobock software, the software may only
be used by qualified personnel.
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1.5 Third-party software is provided without warranty “as is". Ottobock does not provide any warranty of any kind (war-
ranty of merchantability, warranty of fitness for a particular purpose or warranty of non-infringement of rights) with
respect to any third-party software.

2. Licence

2.1 The Ottobock software is protected by national copyright laws in many countries and by international treaties.
Ottobock will prosecute any violation of the copyrights it holds. You are only granted the right to use the Ottobock soft-
ware to the extent required by law or expressly granted to you according to this licence agreement. Ottobock and/or its
licensor(s) expressly reserve all ownership and/or other rights to the Ottobock software, including all copyrights, pat-
ents, business and trade secrets, trademarks and other intellectual property rights.

2.2 By accepting these Terms of Use, you are granted the non-exclusive and non-transferable right for 15 years to use
the Ottobock software for your own purposes in accordance with its intended use, subject to any restrictions con-
tained in these Terms of Use. “Own purposes” refers solely to the purposes of the respective contractual partner. In
the case of medical supply companies or other companies that provide patient services related to Ottobock products
(e.g. prosthesis adjustments), “own purposes” in terms of this licence agreement are also the purposes of the respect-
ive patient who wants to use the Ottobock products in accordance with their intended use.

2.3 You do not have the right to modify, edit, translate, rearrange, or otherwise alter the Ottobock Software nor to
decompile, disassemble, or reverse engineer the Ottobock Software yourself or via third parties unless expressly per-
mitted to do so by law.

2.4 You are authorised to install the Ottobock Software on several computers at the same time, or to use it on a net-
work where the software can be accessed on more than one computer simultaneously. Making the software accessible
to the public is not permitted. For the purposes of these Terms of Use, “computers” shall also be understood to mean
those Ottobock products using the software according to its intended function.

3. Sublicences, assignment

Issuing sublicences for the use of the Ottobock Software is prohibited. Renting, leasing, loaning, or otherwise tempor-
arily ceding the Ottobock software to a third party is also prohibited.

The permanent assignment of the usage rights granted to you is only possible when:

* the third party to whom the rights are to be assigned accepts the terms and conditions of this licence agreement,

* the entire Ottobock software, and not just parts thereof, is assigned, and

» you do not retain any copies of the Ottobock software, not even in the main memory or cache of your computer.

4. Liability

Ottobock is liable to you according to the provisions of the Product Liability Act; in case of intent or gross negligence;
for the loss of life, physical injury or the impairment of health; where Ottobock issues any guarantees; and in other
cases of mandatory legal liability — respectively pursuant to the applicable legal regulations. Damages shall be limited
to an amount representing typically foreseeable damages. Damage compensation claims against Ottobock in case of
slight negligence are excluded.

Any other claims for compensation by you against Ottobock — no matter on what legal grounds and especially due to
material defects, defective title and/or the breach of other obligations arising from the contract on the part of Ottobock,
its legal representatives, employees, or assistants or due to illegal acts — are excluded.

To the extent that the liability of Ottobock is limited or excluded by the preceding provisions, the same applies to the
personal liability of the legal representatives, employees or vicarious agents of Ottobock.

The preceding provisions do not affect the burden of proof to your detriment. Claims for compensation on your part
expire within the legal period of limitation, starting at the beginning of said period as established by law.

Ottobock is not liable for specific fitness or specific characteristics of the Ottobock software.

All claims shall be excluded if you fail to use and operate or modify the software expertly and properly and/or if you
combine or operate the software with unsuitable components.

5. Applicable law and jurisdiction

This licence agreement shall be subject to the laws of the country in which the manufacturer is domiciled. The UN con-
vention on contracts for the international sale of goods does not apply. The exclusive jurisdiction for all disputes arising
from or in relation to this licence agreement is the registered office of the manufacturer.

6. Severability clause

Should one or more provisions of this agreement be or become ineffective or unenforceable in whole or in part, the
validity of the remaining provisions of the agreement shall not be affected.

Any arrangement, change or addition (particularly commitments with respect to characteristics, features or the quality
of the software product) in connection with these Terms of Use shall be deemed void unless made in writing and
unless Ottobock's prior consent has been obtained.
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